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As	the	title	suggests,	this	guide	is	meant	to	be	used	in	a	workshop	setting,	where	partici-

pants	can	work	together	and	a	workshop	leader	can	give	demonstrations,	lead	discussions,	

and	answer	questions.	To	learn	to	use	TinkerPlots™	Dynamic	Data	Exploration	software	

outside	a	workshop	setting,	consult	the	Walkthrough Guide that	comes	with	the	Instructor’s	

Evaluation	Edition	or	supplement	the	activities	in	this	guide	with	the	five	introductory	

movies	that	come	with	TinkerPlots	(choose	TinkerPlots Movies	from	the	Help	menu).

To the Workshop Participant
Welcome	to	TinkerPlots	and	the	world	of	Dynamic	Data.	The	activities	in	this	guide,	which	

begin	on	page	4,	will	introduce	you	to	the	most	important	features	of	TinkerPlots	and	show	

you	how	you	can	use	them	to	help	your	students	understand	data.

At	the	end	of	the	workshop,	take	this	booklet	with	you	to	explore	and	evaluate	TinkerPlots	

in	more	detail.	Remember	that	the	TinkerPlots Workshop Guide is	for	evaluation	purposes	

only	and	is	not	intended	for	classroom	or	other	extended	use.	As	you	become	comfortable	

using	TinkerPlots,	we	encourage	you	to	help	others	by	leading	workshops	yourself.

To the Presenter
We	have	found	that	a	successful	and	simple	workshop	format	for	TinkerPlots	involves	

little	more	than	turning	participants	loose	to	work	in	pairs	with	the	activities	in	this	guide.	

(If	you	prefer	that	participants	work	individually,	have	them	identify	partners	they	can	

consult	when	problems	arise.)	The	Presenter	Notes	suggest	ways	to	introduce	the	activities	

to	participants	as	well	as	places	to	stop	and	have	discussions.	It	is	extremely	useful	to	have	

a	computer	that	can	project	to	a	screen	or	large	monitor	so	that	everyone	can	see	what	you	

do.	Remember	that	teachers	are	not	used	to	sitting	at	a	computer	all	day.	Be	sure	to	allow	

breaks	for	stretching	between	sessions.	When	participants	encounter	challenges,	encourage	

self-reliance	by	suggesting	that	they	read	the	margin	notes,	use	the	Quick	Reference	Card	

and	TinkerPlots	Help,	and	look	through	the	menus.	Show	them	how	to	scroll	over	a	tool	to	

see	what	it	does.	Encourage	them	to	try	things—they	can	always	choose	EditUndo	to	get	

back	to	where	they	were.

Key	Curriculum	Press	grants	copy	permission	to	any	presenter	who	wants	to	give	this	

TinkerPlots Workshop Guide	to	workshop	participants.	Key	Curriculum	Press	also	grants	

permission	to	install	multiple	copies	of	the	TinkerPlots	Instructor’s	Evaluation	Edition		

or	a	single	network	server	copy	for	the	purposes	of	presenting	a	workshop.

Preparing for the Workshop:	In	addition	to	previewing	the	activities	and	practicing	the	

demonstrations,	you	should	complete	the	following	checklist	before	the	workshop.

• Is the most recent version of TinkerPlots installed?	To	make	sure	you	have	the	most	

recent	maintenance	update,	look	on	the	TinkerPlots	Online	Resource	Center.	(Choose	

Check for Updates	from	the	Help	menu.)

Introduction
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• Do TinkerPlots Help and Movies work properly?	Because	TinkerPlots	Help	opens		

in	your	web	browser,	this	is	worth	checking.	Does	Help	launch	from	the	Help	menu?	

Do	the	movies	play,	and	is	there	sound?	(Choose	TinkerPlots Movies	from	the		

Help	menu.)

• Are the computers properly connected to the Internet?	If	not,	you’ll	need	to	work	

around	this	as	you	discuss	importing	data	into	TinkerPlots	(page	12).	You	can	have	

participants	use	the	file	Excel Import.xls,	posted	with	the	TinkerPlots Workshop Guide	

on	the	TinkerPlots	Resource	Center.	Load	this	file	onto	participants’	computers	before	

the	workshop	starts.

•	 Are the necessary TinkerPlots files installed on participants’ computers, and are  

they easily accessible?	Participants	will	work	mostly	with	the	documents	in	the	Data 

and Demos	folder,	which	comes	with	TinkerPlots.	Additionally,	participants	will	need	

the	TinkerPlots	documents	Hall of Fame.tp, Mammal Problems.tp, Scooters.tp,	and	

US States Update.tp	(this	document	corrects	some	errors	in	the	original	US	States		

data	set).	If	participants	are	using	the	Instructor’s	Evaluation	Edition,	they	will	also	

need	the	document	Numbers.tp,	as	this	is	not	included	in	the	Sample	Data	and		

Demos.	If	participants	are	not	connected	to	the	Internet,	they	will	also	need	the	file	

Excel Import.xls,	as	explained	above.	These	files	are	posted	with	the	TinkerPlots 

Workshop Guide	on	the	TinkerPlots	Resource	Center.	(Choose	Online Resource  

Center	from	the	Help	menu.)	You’ll	need	to	load	these	files	onto	participants’	

computers	before	the	workshop	starts.

•	 Am I on the same platform as the participants?	Be	aware	that	if	you	are	on	a	

Macintosh	and	your	participants	are	on	Windows,	or	the	other	way	around,	there	

will	be	some	slight	differences	in	where	the	commands	are	located	and	in	the	way	

TinkerPlots	looks.	These	differences	are	noted	in	the	guide.

Coaching and Modeling:	As	you	coach	participants	on	teaching	with	TinkerPlots	and	

TinkerPlots	techniques,	model	behaviors	you	use	with	students.	Be	explicit	about	your	

modeling	and	encourage	participants	to	use	similar	behaviors	in	their	own	classes.	Use	the	

end-of-session	discussions	to	have	participants	describe	and	comment	on	the	modeling	

they	observed.	Here	are	some	behaviors	to	model	(there’s	no	need	to	model	every	behavior	

in	each	session):

•	 Introduce	the	learning	and	pedagogical	goals	at	the	start	of	each	activity.

•	 Briefly	describe	the	important	techniques	required	by	an	activity.

•	 Do	a	quick	run-through	of	building	a	useful	plot	before	participants	begin	an	activity.

•	 Interrupt	mid-activity	to	demonstrate	methods	or	describe	pitfalls.

•	 Give	participants	plenty	of	time	to	respond	to	questions	and	to	participate	in	

discussions.

•	 Have	participants	summarize	what	they	learned	and	what	challenges	they	encountered.



This	guide	is	meant	to	provide	material	for	a	one-day	workshop.	If	you	have	less	time,	here	

are	two	suggested	formats:

1	hour:	Session	1,	Beginning	to	Look	at	Data

3	hours:	the	above	plus	selections	from	Session	2,	Gathering	Data,	and	Session	3,	

Investigating	Data

About the Instructor’s Evaluation Edition
If	you	do	not	have	a	TinkerPlots	license,	you	may	be	using	the	Instructor’s	Evaluation	

Edition.	This	edition	expires	60	days	after	first	use.	It	has	all	the	features	of	the	full	

version,	with	a	few	important	exceptions.	You	can	open	documents,	import	or	enter	data,	

do	investigations,	and	use	all	the	features	of	the	full	version,	but	you	cannot	save	any	

documents	you	create,	export	the	data	you	generate,	copy	pictures	of	TinkerPlots	objects		

to	paste	into	another	application,	or	print	your	work.

The	full	version	allows	you	to	do	all	these	things,	and	also	comes	with	additional	resources:

•	 Full	set	of	Data	and	Demos—about	40	data	sets	and	9	demonstration	files

•	 Exploring Data with TinkerPlots,	which	includes	seven	classroom-ready	activities	in	

blackline-master	form

vi Introduction TinkerPlots Workshop Guide
 © 2007 Key Curriculum Press
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Session 1 Beginning to Look at Data

 Learning goaLs for this session

Make predictions about the relationship between two characteristics, make graphs 

to investigate a question, and support a conclusion using information from a graph. 

PedagogicaL refLection Questions

How does the investigation approach used in these activities engage students with 

the data (if it does)? What have students learned at the end of these activities?

activities

• Introduction to TinkerPlots (whole-class presentation)

• Backpacks

• U.S. States

resPonse to PedagogicaL refLection Questions

to the Presenter

This session will probably take about an hour. Times given are approximate.

5–10 min: Introduce TinkerPlots either by using the demonstration Introduction 

to TinkerPlots or by showing the movie TinkerPlots Basics. If you choose to do the 

demonstration, you might want to view the movie yourself while you are preparing, 

because the demonstration is based on the movie.

20 min: Participants start using TinkerPlots by answering a question about back-

packs. Make sure you do not let this activity go on too long. Participants will get 

more practice with TinkerPlots in the next activity.

30–40 min: Participants complete the U.S. States activity. This activity often is  

very engaging for participants and is a good segue into a discussion about why  

we study data.
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 Explain that this 
demonstration can 
also be used to 
introduce students 
to TinkerPlots, or 
that TinkerPlots 
comes with a short 
QuickTime movie of 
the demonstration. 

 In this demonstration you’ll use a pre-made file to show the structure of TinkerPlots 

and some basic plot features. Make sure participants don’t try to follow along—

they’ll have a chance to do this very soon. Take about 5 minutes. Explain each step 

of what you are doing.

  1. Open TinkerPlots. Start with a blank document, expanded to fill your screen.

  2. Choose FileOpen, and go to the Data and Demos folder in the TinkerPlots 

folder. Open the Science and Nature folder and then the document Cats.tp. 
Explain that you can enter your own data into TinkerPlots but that it also  

comes with about 40 sample data sets. Most of these have data in different 

subject areas, and some show more advanced capabilities of TinkerPlots.

You may also want to 
make a case table and 
show how selecting  
a case in one represen-
tation highlights it in all 
representations.

 3. Explain that this document contains data about 24 cats. Each cat is represented 

by an icon in the plot. The data for each cat are shown in a data card. The 

attributes are described below the data card. Click on a few points in the plot 

and point out how this brings up their values.

  4. Select the attribute Gender in the data cards, and then click the Key button  

to get a color key. Explain that we can color the icons in the plot according 

to their values for an attribute. Notice that now the males are yellow and the 

females are purple.

  5. Select a numerical attribute such as Age. Explain that for a numerical attribute 

you get a color gradient—the older a cat is, the darker pink the icon is. Click on 

one of the older cats to show its values.

  6. Right now the cases are randomly arranged in the plot. Click the Mix-up button 

to send them to a new random arrangement.

  7. Explain that TinkerPlots does not have a menu of graph types. Instead, students 

build plots by progressively using basic operations that stack, order, and separate 

case icons. This process helps them understand how plots are constructed.

  8. Select Age in the data cards if it isn’t already selected.

  9. Click the Order Horizontal button and explain that it orders the cases, with  

the younger cats on the left and the older cats on the right. Click it again to  

turn order off. 

  10. Click the Order Vertical button, explain what it does, and then turn it off.

  11. Click the Stack buttons one at a time and explain what they do.

  12. With the icons stacked vertically, select Name in the data cards and click the 

Label button.

 The cats will be listed 
in order by their ages.

 13. Select Age in the data cards and click the Order Vertical button.
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  14. Click the Mix-up button, and then click the Key button.

 You could instead 
click the Separate 
Horizontal button.

 15. Click on one of the icons. Drag it to the right and let go. This separates the plot 

into two groups: young cats and old cats. Drag a little more until you have four 

or five groups. Click the Stack Vertical button. 

 If participants ask 
about the cat image 
icons, explain that you 
can attach an image 
icon to a document 
using the file Case 
Icon Library.tp  
in the Data and 
Demos folder.

 16. Choose Circle Icon from the Icon Type menu, and then choose Fuse 
Rectangular. Explain that you can use icons other than cats to represent cases. 

Here each case is represented first by a circle and then by a rectangle.

  17. Drag an icon to the right until the icons become fully separated, and each icon 

sits above its value on the horizontal axis. Then choose Circle Icon from the 

Icon Type menu and make the icons smaller.

  18. To look at a different attribute, drag BodyLength from the data cards and drop  

it below the horizontal axis.

 In these steps, you are 
modeling an inquiry, 
but it isn’t necessary 
to say so explicitly.

 19. Explain that you can use color in TinkerPlots to explore relationships between 

attributes. Point out that in this plot there are two clumps. Wonder aloud 

whether we have some younger cats that are shorter and some older cats  

that are longer.

  20. Click on Age in the data cards if it isn’t still selected. If we did have older cats 

that were longer, we’d expect to see more dark pink at the right and more light 

pink at the left. But we don’t. Maybe the males are longer than the females.

  21. Click on Gender in the data cards. The clump at the left is mostly females and 

the clump at the right mostly males, so it seems that we might be right.

  22. To explore this idea further, drag an icon up. When you let go, the plot should 

separate, showing one graph for males and one for females.

  23. Explain that you can use the toolbars to add features to your plot. Show the 

mean and reference lines by clicking the Mean and Ref. buttons. Use the 

Drawing tool to draw the shape of one of the distributions. 

  24. End the demonstration by choosing EditUndo to go back several steps. 

Explain that TinkerPlots has unlimited undo, so participants shouldn’t be  

afraid to try something to see what happens.

Presenter Notes introduction to tinkerplots
continued
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In this activity participants start using TinkerPlots. There are no specific steps 

for them to follow. The purpose is for them to begin to be comfortable using 

TinkerPlots to make plots.

  1. Explain that this activity follows the model of a five-part investigation: First 

participants will ask a question, then they will think about it (make hypoth- 

eses), then they will analyze the data, and finally they will use their analysis  

to support a conclusion. (The middle step of collecting the data has already 

been done for them.)

  2. In this activity participants will use data provided with TinkerPlots to investi-

gate the question: Do students in higher grades carry heavier backpacks? When 

students look at data, it’s essential that they begin with a question and that they 

understand what the attributes mean. This example is a question dear to the 

hearts of many students, and the attributes are familiar to them.

 Multiple copies of the 
Quick Reference Card 
come with full versions 
of TinkerPlots, and can 
help answer students’ 
immediate questions.

 3. Show participants where to find the data set, and remind them to use the  

Quick Reference Card in the back of this guide if they have questions.  

Allow about 15 minutes for exploration. Don’t prolong this activity. 

 
If some participants 
finish early, have 
them investigate the 
question: Do males or 
females carry heavier 
backpacks?

 4. After most people have a plot they are satisfied with, bring the group together 

for a brief discussion. Ask what their conclusions are: Do students in higher 

grades carry heavier backpacks? Ask volunteers to explain how their plots 

support their conclusion. Point out the very different plots that have been 

created around the room.

  5. Bring out the need to look at body weight as well as backpack weight to decide 

the question, and demonstrate how to create a new attribute, PercentWt, and 

define it using a formula (the directions are in the activity).

   Participants might bring up this need during the exploration. In that case, pause 

the session and do the demonstration earlier.

  6. Have participants create the new attribute themselves and answer the last 

question in the activity. Briefly bring the group together to discuss their 

answers. This will probably take about 10 minutes.

The activity shows 
the formula editor 
as it appears on 
a Macintosh. The 
appearance is slightly 
different on Windows, 
but the instructions are 
exactly the same.

 

Presenter Notes backpacks
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Backpacks

When students are looking at data, it’s essential that they begin with a question and 

that they understand what each of the attributes means. In this activity, you’ll look 

at data collected by students attempting to answer the question: Who carries the 

heaviest backpacks? You’ll investigate part of that question.

  1. Open TinkerPlots. Choose FileOpen and go to the Data and Demos folder. 

Open the Exploring Data Starters folder and then the document Heaviest 
Backpacks.tp. This file contains data about the backpack weights of students  

in grades 1, 3, 5, and 7. 

  2. Look at each of the attributes. If you aren’t sure what an attribute is, read the 

description below the data card.

think about it

You’re now ready to explore the question: Do students in higher grades carry 

heavier backpacks? 

  3. Before you begin analyzing the data, think about what you expect to see.  

Briefly discuss the question with a partner. 

PLot and investigate

  4. Make two different plots that answer the question. Don’t be afraid to try 

something to see what happens. Some tips:

• Refer to the Quick Reference Card at the end of this guide if you have  

a question.

• You can click on the buttons in the toolbars to add features to your plot. 

 

 

  • You can get a new plot by dragging the Plot icon from the toolbar into  

the document.

 • If you do something you didn’t mean to do, choose EditUndo. Sometimes you 

might get a plot that looks like this. If this happens, undo and think about what 

went wrong.

  5. What is your conclusion for the question: Do students in higher grades carry 

heavier backpacks? How do your plots support your conclusion? Is this what 

you expected to see?



create a new attribute using a formuLa

When you were looking at who carries the heaviest backpacks, it might have 

occurred to you that it would be good to consider the weight of the students  

as well as the weight of the backpacks. You can create a new attribute that will 

calculate the percent each student’s backpack weight is of his or her body weight. 

Here’s how.

  7. In the data cards, double-click <new attribute> and type PercentWt.

  8. Expand the data cards to the right until you see the Formula column. Double-

click the circle for PercentWt.

  9. Enter the formula into the formula editor. You can either type the attribute 

names or expand the Attributes list and double-click them.

  10. When you’re done, click OK. Each case should have a value for PercentWt.  

The values are gray to show that they were calculated.

   

  11. Change your plots to look at PercentWt. Does this new information change  

your conclusion?

 Tip: Use a reference 
line to find those 
students who are  
at risk.

 12. If you finish early: Some doctors believe that students carrying backpacks  

that weigh more than 15% of their body weight might injure their backs.  

How many of these students are at risk?

� Beginning to Look at Data TinkerPlots Workshop Guide
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Presenter Notes u.s. states

The U.S. States activity helps participants get more enthusiastic about data 

analysis by using data they are probably more interested in than backpack weights. 

Participants also look at relationships between attributes in more detail. If your 

group includes more social studies teachers than math or science teachers, you 

might want to spend more time with this data set. In addition to doing the activity, 

have participants explore relationships on their own. Discuss what social studies 

concepts students could explore here.

  1. Open the document US States.tp in the Data and DemosSocial Studies 

folder and expand it to fill your screen. Explain that this data set was put 

together specifically for teachers rather than for students—it contains attributes 

teachers know and care about, such as NAEP scores and teacher salaries. Show 

participants how to expand the data cards to see all the attributes.

  2. Point out that because we have the latitude and longitude of the capital cities, we 

have a rough map of the United States. We can use this map in several different 

ways to look at trends, or to pick out individual states. One way is to color the 

map with an attribute. For example, when you open the data set, the map is 

colored by Area. We can also use highlighting in two plots to look at trends.

  3. Make a new plot, below the map, and turn off the attribute color by clicking on 

the blue bar by the word Attributes.

  4. Make a line plot (dot plot) of Rainfall_Annual on the second plot: Drag 

Rainfall_Annual to the horizontal axis and fully separate.

To select multiple 
points, draw a 
selection rectangle 
around them.

 5. Explain that you’re going to highlight the states with low rainfall on the line 

plot. Ask participants where they think those states will be on the map. Then 

select the low-rainfall states. Were the participants right? Repeat with the high-

rainfall states.

  6. Have participants complete the U.S. States activity. This will probably take about 

30 minutes. Then lead the group in a discussion about the activity.

 See Exploring Data 
with TinkerPlots, 
Making and Research-
ing Your Own Data,  
p. 17, for some ideas.

 • What did you find in the U.S. States data set?

  • What characteristics of this data set would make it challenging for middle-

school students to use?

To delete an attribute,  
select it in the data  
cards. Choose Edit 
Delete Attribute. To hide  
an attribute, move it to the 
bottom of the list using cut 
and paste, and make the  
data cards smaller so it  
can’t be seen.

 • What are some characteristics that you should look at when choosing data?

  • What are some ways you could modify this data set to make it easier for students 

to use? (Show participants how to hide or delete attributes. Explain that they 

will work more on cleaning up data for student use in the next activity.)
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U.S. States

In this activity you’ll explore data from the 50 U.S. states. You’ll look at how the 

states compare in terms of how much they spend on education, how they perform 

on NAEP, and whether there is evidence of a relationship between spending and 

educational performance. 

think about it
Before you look at data, you should think about what you expect to see. 

  Q1 About how much do you think states typically spend per year per student?

  Q2 List three states that you expect spend more than the average per student and 

three states that you expect spend less than the average.

   More:  

   Less:  

  Q3 Estimate where you think your state ranks on each attribute.

   My state  

Public school spending 
per student

 a. Ed_Spending: Below average Average Above average

 b. TeacherSalary: Below average Average Above average

Average score on math 
section of NAEP for 
eighth-graders

 c. Gr8Math_NAEP: Below average Average Above average

 d. IncomePerCapita: Below average Average Above average

  Q4 At the time these data were collected, 39 states had lotteries and 11 did not.  

Do you expect that states with lotteries spend more (per student) on average?  

If so, about how much more on average do you think they spend?

  Q5 Do you expect to find a relationship between how much a state spends per 

student and the performance on math NAEP scores of eighth-graders?

PLot and investigate
Open the document US States.tp. For each question, make a graph that helps you 

answer the question. Consider how well your estimates reflect the data. 

  Q6 How much do states typically spend per year per student?

  Q7 Make a graph that you can use to locate the six states you listed in Q2. Were you 

correct in your expectations?
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  Q8 For each attribute below, determine approximately what percent of states are 

ranked lower than your state.

Click the Div. and % 
buttons on the upper 
plot toolbar.

       

  This graph shows the percentile of Massachusetts for TeacherSalary (that is, 

what percent of states have lower teacher salaries than Massachusetts). The 

graph uses dividers and percents to show the percent of states that rank  

below Massachusetts.

  a. Percentile for Ed_Spending  

 b. Percentile for TeacherSalary 

 c. Percentile for Gr8Math_NAEP 

 d. Percentile for IncomePerCapita 

  Q9 Do states with lotteries typically spend more per student? If so, about how much 

more do they typically spend?

  Q10 Is there a relationship between   

how much a state spends per  

student and the math NAEP  

scores of eighth-graders? 

See Binned Scatter 
Plot in TinkerPlots Help 
for details about how 
to make this graph.

  This graph is a good one to  

illustrate relationships between  

two numeric attributes. You can  

see the mean of TeacherSalary  

(blue triangles) increasing for  

higher levels of IncomePerCapita.

  Q11 If you finish early, explore other attributes in the data set. Think about 

relationships that might exist between attributes and then make graphs  

to test your hypotheses.

discussion Questions

  1. Teachers have used this data set with sixth-grade students, and it has not been a 

pleasant experience! What about these data makes them particularly challenging 

for younger students?

  2. What are some of the characteristics of data that you should consider when 

deciding whether to use a particular data set with your students?



 Learning goaLs for this session

Be able to find or enter data and make it usable for your students.

PedagogicaL refLection Questions

How do the data that students work with affect what they learn? How do you 

choose the data students will work with?

activities

• Importing Data into TinkerPlots

• Entering Data into TinkerPlots

resPonse to PedagogicaL refLection Questions

to the Presenter

This session probably will take about an hour. If you are short on time, omit the 

second part of Importing Data into TinkerPlots.

30–40 min: Demonstrate how to import data into TinkerPlots and have participants 

explore websites with data. They then practice fixing some problems common to 

data downloaded from the Internet.

20–30 min: Have participants work on entering data. The goal of this session is 

more for participants to understand what case-based data are and how to recognize 

them than for them to be able simply to enter data into TinkerPlots.

Session 2 Gathering Data
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In this activity you’ll first demonstrate how to download data from the Internet and 

then have participants download data for themselves and decide whether particular 

data sets are appropriate for their students. Both you and the participants need to 

be able to access the Internet. If you do not have Internet access, modify the first 

part of this activity by having participants import data from a Microsoft Excel file. 

See the notes below.

In either case, have participants watch while you demonstrate how to import the 

data into TinkerPlots. Make sure that participants don’t try to follow along, perhaps 

by having them turn away from their computers.

Participants then use a pre-made file, Mammal Problems.tp, to practice finding 

and fixing common errors in imported data. You can skip this activity if you are 

short on time, but it will be valuable for participants when they try to work with 

their own data.

imPorting data from exceL

  1. Before the workshop, download the Excel document Excel Import.xls from the 

TinkerPlots Resource Center at www.keypress.com/tinkerplots/resources. Load 

this file onto all the workshop computers.

  2. Explain that TinkerPlots can import data from many different applications, 

such as Microsoft Word, spreadsheet programs like Excel, and websites. There 

are three ways to import data: by copying and pasting, by importing from a text 

file, or by downloading from the Internet.

  3. First we’ll copy and paste. Open the Excel file. Highlight all the data, including 

the attribute names. Make sure nothing else is highlighted. Choose Copy from 

the Edit menu.

You can import data 
into any TinkerPlots 
file, but using a blank 
document makes it 
easier for participants 
to follow.

 4. Open a new, blank TinkerPlots document. Make a new stack of data cards and 

make sure this stack is selected.

  5. Choose Paste Cases from the Edit menu.

  6. Make a graph or a case table to demonstrate that the data are there.

Many programs can 
save documents as 
text files. Make sure 
the attribute names 
are in the first row and 
the document contains 
nothing but the data.

 7. Optional: To demonstrate how to import from a text file, go back to Excel. 

Choose Save As from the File menu and save the data as a Text (Tab delimited) 

file. In TinkerPlots, make sure nothing is selected and then choose Import From 
File from the File menu. Select the file you want to import, and click Open.

Presenter	Notes	 ImportIng data Into tInkerplots
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You’ll learn more about 
the difference between 
summary data and 
case-based data in  
the next activity.

 There is an amazing amount of data on the web. Many of the data you’ll find online 

are summary data, and you can’t do much with those when you download them 

into TinkerPlots. But when the data are case-based—that is, when they give you 

individual pieces of information (values of attributes) for many cases—you can 

download them into TinkerPlots and investigate them. In this activity you’ll learn 

how to import data from the web into TinkerPlots and how to solve problems that 

can occur when you download data.

downLoading data from the web

The Data and Story Library (DASL) is an online library of data sets useful for 

education settings. All the data on DASL are case-based and are formatted so that 

they export into TinkerPlots with no problems.

  1. Open a new TinkerPlots document, then open your web browser and position  

it to the right of your screen so that you can see the TinkerPlots document on 

the left.

  2. Type DASL into a search engine to locate the Data and Story Library. In DASL, 

click on Data Subjects, and then select one of the several subjects offered there. 

Within the subject, click on a particular data file. At the top of the page, you  

can read a description of the data set. Below the description are the actual  

data Note that cases are listed in separate rows and that each column is a 

separate attribute.

 3. To download the data into TinkerPlots quickly, drag the URL of the web page 

that contains the data and drop it into the blank TinkerPlots document. The 

data appear in a new stack of data cards.

  4. If you want to add the comments or attribute descriptions to your TinkerPlots 

document, copy the text. Then in TinkerPlots make a new text box. Choose 

Paste Text from the Edit menu.

Try following the links 
from the TinkerPlots 
Resource Center: 
www.keypress.com/
tinkerplots/resources.

 5. Investigate at least three data sets and list them below. Indicate whether you 

think each would be appropriate for your students, and give reasons for your 

decision. If you know of other sources on the web, look there.

Importing Data into TinkerPlots
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Importing Data into TinkerPlots
continued

fixing ProbLems in data

Often when you download data from the web, it won’t be as clean and tidy as the 

data from DASL. In this activity, you’ll use a data set someone else has downloaded 

from the web to practice finding and fixing common problems.

  6. Open the document Mammal Problems.tp.

  7. Find as many errors as you can and fix them. You can do this on your own or by 

following the directions below. Some tips:

  • Use a case table to look at all the data at once.

• If the attribute names weren’t imported correctly, they might be the values of 

the first case.

• You can create new attributes using formulas to fix many problems. See steps 

12–18 for an example.

• Units should go in the Unit column. They should not be part of attribute names 

or values.

• Remember that numerical attributes (those with numbers as values) should 

have a color gradient and that categorical attributes (those with words as 

values) should have a band of discrete colors.

• Blank values sometimes are represented with an asterisk (*). In TinkerPlots, 

blank values should actually be blank.

  8. Make a case table by dragging a new table into the document.

One of the first things you’ll probably notice is that the attributes have default 

names, such as ATTR1 and ATTR2.

 You can press Tab 
to move to the next 
attribute name.

 9. Rename the attributes by double-clicking an attribute name and typing in a new 

name. Use the values for case 1 to determine the proper attribute names. 

  10. Notice that height is in meters. Delete “meters” from the attribute name and 

type it in the Unit column.

  11. The first case shows the attribute names rather than meaningful values. To 

delete that case, click the blue circle by the case number or click the row number 

in the table. Choose EditDelete Case.
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Follow these steps to fix a problem by creating a new attribute using a formula. Here 

the values for the attribute Mass include the unit “kg.” We want to delete the unit 

from all the values (without editing them one by one).

  12. Make a new attribute called MassTemp.

  13. Expand the data cards until you can see the Formula column. Double-click the 

circle for MassTemp.

  14. Enter this formula into the formula editor and click OK. The text function 

stringToNumber looks for numbers in a value and deletes any text.

   

   The values for MassTemp should match the values for Mass. The MassTemp 

values are gray to show that they were calculated.

If you don’t clear the 
formula before you 
delete the original 
attribute, all your 
values for MassTemp 
will disappear. If this 
happens, choose 
EditUndo.

 15. Select MassTemp and choose Clear Formula from the Edit menu.

  16. Select Mass and choose Delete Attribute from the Edit menu. Then rename 

MassTemp as Mass.

  17. Type kg in the Unit field for Mass.

  18. If you want to move the attribute, select it and choose EditCut Attribute. 
Then select the attribute below where you want it to appear and choose 

EditPaste Attributes.

Remember that numeric attributes should have a color gradient and that categorical 

attributes should have a discrete color for each value.

Asterisks (*) are 
sometimes used 
to represent blank 
values. In TinkerPlots, 
blank values should 
actually be blank.

 19. Look for attributes with the wrong type of color bar. To see what’s wrong, either 

graph these (drag the attribute to the vertical axis to see a list of values) or look 

in the case table. Fix any errors. 

Importing Data into TinkerPlots
continued
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The values for Diet are “plants,” “animals,” and “both.” Suppose you want students 

to practice using the terms “herbivore,” “carnivore,” and “omnivore.” You can easily 

change the values by creating a new attribute using a switch-statement.

  20. Create a new DietTemp attribute and double-click its formula circle to show  

the formula editor.

  21. Enter the formula shown and click OK. This formula tells TinkerPlots to give 

DietTemp values based on the values of Diet but switched.

   Tips on entering the formula: 

• Once you type switch( all the parts  

of the statement will appear.

• Type words inside double quotes  

(a pair of double quotes appears  

when you type one).

• To get the middle line of the  

statement, position the cursor at  

the end of the first line and press  

Ins (Win) Option+Enter (Mac).

You can use switch-statements for many different things in TinkerPlots. If you want 

to change only two values, you can use something similar called an if-statement. See 

TinkerPlots Help: Working with Formulas for details.

  22. Clear the formula for DietTemp and delete Diet as you did with MassTemp in 

steps 15 and 16.

  23. If you finish early, explore the Mammals data set. Here’s one question you might 

look at: Is there a relationship between how long mammals sleep and how long 

they live? If you think there is, describe it and try to explain it. 

Importing Data into TinkerPlots
continued
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In this activity participants start to think about how to build a data set from scratch. 

What types of data work well in TinkerPlots? How do you structure data to allow 

students to explore them?

  1. Introduce the tree activity simply by presenting the problem. Have participants 

work in pairs for 5–10 minutes to enter the data.

  2. Ask for volunteers to explain what they did. Participants likely will have used 

two different methods: Some will have entered summary data, and some will 

have entered case-based data. 

   Summary data aggregate the information in some way. Here the totals are given 

for the number of trees of each type in each area. In TinkerPlots, a case is the 

information on a data card, or in a row of a case table, so here the case is not  

an individual tree, but rather a tree type.

   

   Case-based data, or microdata, give data for each individual. Here each 

individual tree is entered separately. The case is a tree.

   

For more information 
about the importance 
of the case, see 
Research on Student 
Thinking About Data, 
page 60.

 3. Discuss the advantages and disadvantages of each method. Bring out the 

distinction between summary data and case-based data. TinkerPlots is 

structured to work with case-based data. However, how you define a case 

depends on what you want to do with the data. For example, if we were 

comparing global properties of chinaberries to global properties of sugar 

maples, then it would make sense to use the tree type as the case. (This is 

how the mammals data were set up.) The subtlety of this distinction makes 

it important for teachers and students to understand what the case should be 

in any data-gathering situation. If they do not, they are likely to be surprised 

or confused when they graph their data. In the tree activity, for example, 

participants were probably expecting to see about 30 cases. Instead, they  

might see only four.

Presenter	Notes	 enterIng data Into tInkerplots

These examples do 
not show the data that 
participants are using.
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Presenter	Notes	 enterIng data Into tInkerplots
continued

  4. Have participants work in pairs on the next part of the activity. Here they  

need to build a data set from scratch. Take 5–10 minutes for this.

  5. Discuss participants’ reactions to this activity.

• What problems did you encounter, either in choosing a topic or in entering  

the data?

• The trees activity is based on a real data-gathering activity and on problems 

 that arose during that activity. Can you think of other data-gathering situations 

in which you or students might be confused about what the case should be?
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Entering Data into TinkerPlots

For class projects, you might have to build a data set from scratch. To do this,  

open a new TinkerPlots document, drag a new stack of data cards into the 

document, and begin entering attribute names and values for each case. The 

information for each case goes on a separate data card. You can also make a  

case table and enter the data there.

trees

The diagram below shows four different species of trees growing near a river.  

There are two different areas: close to the river and far from the river. You need  

to enter data into TinkerPlots to answer this question: Does one type of tree  

grow more in one area than in another?

far

close

far

close

river

Beech

Chinkapin Oak

Hackberry

Persimmon



coLLecting data

A case-based data set is a collection of cases and their attributes. There might be a 

collection of individual

• students, where the attributes are age, gender, name, and height

• marbles, where the attributes are diameter, color, type, and manufacturer

• class episodes, where the attributes are number of minutes, current activity, 

number of students on task, and room temperature

Your task is to collect cases and enter the data into TinkerPlots. The collection 

should have these properties:

• It cannot be a collection of people—this is too easy!

• The collection should not be information you get off the web. It should be 

something you and your partner can observe in your immediate environment.

• It should include at least five cases and three attributes.

• The attributes should include at least one numeric and one categorical attribute.

refLection on the activity

Summarize any difficulties you had, either in deciding on a collection or in entering 

the data appropriately into TinkerPlots.
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Entering Data into TinkerPlots
continued
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Session 3 Investigating Data

 Learning goaLs for this session

Investigate properties of whole numbers, understand how outliers affect means and 
medians, and understand the relationship between a scatter plot of two attributes 
and a line plot (dot plot) of the ratio of those two attributes.

PedagogicaL refLection Questions

Does viewing numbers as data change your perception of them? How does using 
TinkerPlots make the concepts in these activities clearer (if it does)? 

activities
• Numbers (subsidiary activities Factors and Number Properties from Exploring 

Data with TinkerPlots)

• Changing Means and Medians (from Digging into Data with TinkerPlots by  
Amy Brodesky, Amy Doherty, and James Stoddard, Key Curriculum Press, 2008)

• Connecting Line Plots and Scatter Plots (from Digging into Data with TinkerPlots)

resPonse to PedagogicaL refLection Questions

to the Presenter

In this session participants move from using TinkerPlots primarily as a tool for  
data analysis and exploration to looking at some ways they can use TinkerPlots  
to illustrate mathematical concepts. If your group includes more science teachers 
than math teachers, you’ll want to focus more on the ways to use TinkerPlots to 
explore relationships than on the purely mathematical exploration of numbers. 
This session will probably take about 2 hours. You can demonstrate one or more  
of these activities if you’re short on time.

30–45 min: Participants explore properties of the whole numbers from 1 to 100.

40–50 min: Model the activity Changing Means and Medians as a complete lesson.

30–40 min: Participants complete two worksheets on connecting line plots  
(dot plots) with scatter plots.

5–15 min: Optional: Show one or more of the three TinkerPlots movies on 
teaching techniques: Making Common Graphs, Comparing Groups, and Exploring 
Relationships. Watch these as a group or have participants watch them on their own. 
If participants don’t have headphones, watching the movies on their own computers 
will be very loud and distracting because the sounds will not be synchronized.
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This activity is a purely mathematical exploration. Participants use graphs that 

show numbers as points of data to look at patterns in number behavior.

  1. Introduce the activity by opening the document Numbers.tp in the Data and 
DemosScience and Nature folder and demonstrating how to change the size 

of the stack.

 Although the Factors 
and Number Properties 
activities have students 
open different files, 
these files contain 
exactly the same 
data as Numbers.tp. 
The attributes were 
rearranged to suit the 
focus of the activity.

 2. Have participants spend about 20 minutes with this document. They can  

work on the Numbers activity, which was written for teachers, or on the  

Factors and Number Properties activities, which were written for students. 

Make sure participants see the activity notes following the activities. The 

Extensions contain other questions that can be investigated with this  

data set.

  3. Lead participants in a discussion of what mathematics they could teach using 

this data set.

Presenter	Notes	 numbers
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Numbers

In this activity you’ll use TinkerPlots to explore something we don’t normally  

think of as data—numbers.

  1. Choose FileOpen. Go to the Data and Demos folder, then the Science and 
Nature folder. Open the document Numbers.tp.

Here we have different properties for each number from 1 to 100, such as whether 

the number is a multiple of various numbers, whether the number is a perfect 

square, and whether it’s prime. The plot is already set up to be an ordered stack.

If you ever lose your 
stack, see steps 11–13 
to get it back.

 2. Change the size of the stack by dragging the bottom right corner of the plot. 

What kinds of questions could you ask students here?

  3. Click on one of the factor attributes, such as factor8. Experiment with finding 

different patterns by changing the stack. What mathematical properties do these 

patterns show? 

To compare plots, 
make a new plot: 
Select the plot and 
choose Duplicate Plot 
from the Edit menu.  
To lock the color on 
one plot, click the  
Key button and  
then click the lock  
on the key.

 4. Click on a different factor attribute and compare the patterns. When does the 

pattern in one stack appear in another stack?

  5. Click on the attribute prime. What’s different about the patterns found in this 

stack? Can you make stacks that have roughly regular patterns?

You can also use different types of icons to look at patterns.

  6. Choose Fuse Circular from the menu at the bottom of the plot. Here you can 

see that the primes aren’t evenly distributed. Try clicking on some of the other 

attributes to look at their distributions. What do you notice?

  7. Choose Square Icon from the menu to go back to a stack.



The data cards also contain attributes that show each number’s digit sum and ones 

digit. You can use these attributes to look at many patterns as well.

  8. Drag digit_sum from the data card to the horizontal axis of the plot.

  9. Drag a plot icon to the right until there are no more bin lines. Then, using the 

slider on the plot, make the icons small enough that they don’t overlap.

   

   Why does the plot have this shape?

  10. Click on factor3. What arithmetic rule does this show? What about factor9?

These are just a few of the number patterns you can look at using this data set. 

Spend the next few minutes finding others. If you like, answer one of the questions 

in the document, or look at the Factors and Number Properties activities on 

pages 24 and 27. Be sure to check out the activity notes on pages 30–36 for some 

interesting extensions. These activities are from the book Exploring Data with 

TinkerPlots that comes with TinkerPlots.

Tip: To get a stack, follow these steps:

  11. Drag the Plot icon from the toolbar into the document to make a new plot, or 

click the Mix-up button on the old plot.

  12. Click on number in the data cards and then choose Square Icon from the menu 

in the plot. If labels aren’t showing, click the Label button.

  13. Click the vertical Order button, then the vertical Stack button.
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Numbers
continued
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26 • Activities Exploring Data with TinkerPlots
© 2005 Key Curriculum Press

Factors Name(s):

In this activity you will explore patterns
related to multiplication. You’ll look at
properties of the numbers 1 to 100. At right
are the data for the number 24. Notice that the
value for factor3 is “yes.” This means that 3 is
a factor of 24. You can see that 2, 3, 4, 6, 8, and
12 are all factors of 24.

Plot and Investigate

Now you’ll look at the data to see what
patterns you can find.

1. Open the document Factors.tp. You’ll see
a stack of data cards like the one at right.

2. You’ll also see a plot of square icons
stacked and ordered by number. Drag the
right and bottom edges of the plot. You’ll
see the square icons move around to form
stacks of different sizes.

3. Drag the edges or corner of the plot so that the
stack is 3 wide, as shown here. You can also
use the Icon Size slider to make the squares fit
better.

Q1 Describe any patterns you notice in this stack.

4. Now select the attribute factor3 in the data cards. The color of the plot
should change. (The key above the plot tells you what the colors
mean.)

Q2 Describe any patterns you notice in the stack now.
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Factors (continued)

Exploring Data with TinkerPlots Activities • 27
© 2005 Key Curriculum Press

Q3 What do you think will happen if you make the stack 5 wide and
select the attribute factor5? Write your prediction, and then try it.

Q4 In general, what will happen if you make a stack of a particular width
and select the same factor as the width? Why does this happen?
Include a copy of at least one graph that backs up your answer.

You probably know that division is the inverse (or opposite) of
multiplication. You can use your plot to explore division too.

5. Think about the division problem 24 ÷ 8. You probably already
know the answer is 3. This means that there are 3 groups of 8 in 24
(or 8 groups of 3 in 24). Because you are dividing by 8, make a stack
8 wide and select factor8. Look for 24 in the stack.

Q5 What does the color of the icon for 24 tell you?

Q6 How high is 24 in the stack? How does this relate to 24 ÷ 8?
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Factors (continued)

28 • Activities Exploring Data with TinkerPlots
© 2005 Key Curriculum Press

6. Think about the division problem 24 ÷ 8 again. Because you are
dividing 24, make the stack 24 wide but keep factor8 selected. Look
for 24.

Q7 How does this plot show you that 24 ÷ 8 = 3?

Q8 Use either method of making a plot to do these division problems. For
at least one problem, include a copy of your plot and explain how it
gives you the answer.

a. 18 ÷ 3 = b. 26 ÷ 13 =

c. 11 ÷ 2 = d. 8 ÷ 3 =

7. As you change the size of the stack, you probably see the factors
create different patterns in the stack. Experiment with different sizes
and different factors to find one pattern that is interesting to you.
Include a copy of this plot with your assignment.

Q9 Describe why this pattern is interesting to you. If you can, explain
how the width and factor combine to create the pattern.
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Exploring Data with TinkerPlots Activities • 29
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Number Properties Name(s):

In this activity you will explore the whole numbers 1 to 100. You’ll look at
three types of whole numbers.

Square numbers are produced by multiplying a number
by itself, such as 4 × 4 = 16. You say that 16 is a perfect
square. You can represent a perfect square number by
arranging objects in the shape of a square. At right is a
square made up of 16 smaller squares, showing that 16
is a perfect square.

Triangular numbers can be represented by objects arranged in the shape
of an equilateral triangle. Here are triangles that represent the first four
triangular numbers. What are the numbers?

Prime numbers have only two factors—1 and the number itself. For
example, 5 is a prime number because its only factors are 1 and 5.

At right are the data for the number 36. The
“yes” and “no” values for the attributes show
that 36 is a perfect square and a triangular
number, but it is not prime.

Plot and Investigate

Now you’ll look at the data to see what
patterns you can find. Let’s start with the
perfect squares.

1. Open the document Number Properties.tp. You’ll see a stack of data
cards like the one above.

2. You’ll also see a plot of square icons ordered by
number. Drag the bottom edge, right edge, or
bottom-right corner to make a stack that is 4
wide, as shown at right. You can also use the
Icon Size slider to make the squares fit better,
but don’t make them too small.

3. Select the attribute perfect_square in the data
cards. The color of the plot will change, as
shown at right. Include a copy of this plot with your assignment.
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Number Properties (continued)

30 • Activities Exploring Data with TinkerPlots
© 2005 Key Curriculum Press

Q1 Do you see a pattern to the square numbers in the plot? Describe the
pattern as fully as you can.

Q2 Assume that you have data for numbers greater than 100. Based on
the pattern that you see, where will the next five perfect squares
appear? If you can, figure out the value of those square numbers.

4. Drag the edges or corner of the plot to change the size of the stack.
Find another stack that helps you see a pattern to the square numbers.
Include a copy of this plot with your assignment.

Q3 Fully describe the pattern that you see in this stack. Explain how this
pattern compares with the pattern that you saw in Q1.

Now you’ll look at the triangular numbers.

5. Select the attribute triangular in the data cards. Change your plot or
make a new plot that shows a pattern to the triangular numbers. Feel
free to experiment with different options. For example, you don’t have
to use square icons. Include a copy of your plot with your assignment.

Q4 Describe the pattern that you see in the triangular numbers as
completely as you can. Based on your pattern, what are the next five
triangular numbers greater than 100?
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Now you’ll explore the prime numbers.

6. Select the attribute prime in the data cards.

7. Make at least one plot that shows possible patterns for the prime
numbers. Include a copy of your plot(s) with your assignment.

Q5 Describe any possible patterns that you see in the prime numbers.
Your answer should say how your plots help you see these patterns.
Can you use the patterns to predict the next five prime numbers
greater than 100?
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minimum or maximum body weight or for
using a range of values rather than one
absolute value.) You might extend this into a
discussion about how teachers, parents, and
school board members might use this
information when adopting textbooks or
shaping school policy.

4. This activity focused on differences between
grade levels. Ask students to continue
analyzing the data to find differences between
genders or body weights. Body weight is
particularly interesting because students can
debate to what degree body weight depends on
grade level. (This raises the distinction between
correlation and causation. Does gaining body
weight cause students to carry heavier
backpacks? Probably not. Rather, as students
get older, their body weight increases, they
move into higher grades, and they have more
homework.)

For students in grades 6–8, you can even begin
to look at bivariate relationships between
attributes. For example, what does a scatter
plot of BodyWeight and PackWeight tell you? (As
body weight increases, the backpack weight
tends to increase, but there are plenty of
exceptions.) If students are novices with scatter
plots, other types of plots, such as binned
scatter plots, may be an easier way for them to
recognize the relationship between the two
attributes.

Links

You and your students can find links to additional
data and information about backpack weight and
safety at the TinkerPlots Online Resource Center.
Choose Online Resource Center from the Help
menu or go to www.keypress.com/tinkerplots.

Factors (page 24)
Activity Time: 30–55 minutes

Required Document: Factors.tp from the folder
Data and Demos | Exploring Data Starters. This
document uses the same data as Number

Properties.tp in this folder and Numbers.tp in the
folder Data and Demos | Science and Nature. In
each document the attributes are ordered by their
use in the activity.

Prerequisites: Students need to know basic
multiplication and division of whole numbers.
Preferably, students are familiar with the
mathematical term factor.

Mathematics: Students will recognize different
representations for the same number; select, apply,
and translate among mathematical representations;
describe numbers in terms of their factors;
understand various meanings of multiplication and
division; and understand the inverse relationship
between multiplication and division.

Connections: This activity is primarily
mathematical. However, students will enjoy the
patterns that result from changing the width of the
plot and coloring by different factors. This can lead
them to general observations that they need not
formalize. For example, to get perfectly diagonal
patterns, you make the stack one wider or narrower
than the factor.

General Notes: This activity explores the
connection between multiplication and division, and
between factors and multiples. Students use roughly
rectangular stacks of the numbers 1 to 100 and color
every multiple of a specific factor. The patterns
created by the colored numbers help them identify
every multiple of the factor.

The primary goal of this activity is for students to
explore how they can describe whole numbers in
terms of their factors. Most middle-school students
have probably had experience representing
multiplication with a rectangular arrangement
of blocks. This activity takes advantage of that
familiarity and builds on it by allowing students to
quickly change the height and width of the rectangle
to see what products result.

The student worksheet is relatively straightforward,
giving step-by-step instructions for creating a few
plots and asking specific questions about those
plots. For students in grades 6–8, you may want to
break away from the worksheet and encourage
students to do independent explorations of the
factor patterns. Students will find them compelling
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and describe many patterns. The extensions at the
end of these activity notes offer suggestions for
going even further into algebraic concepts and
primes.

A secondary goal is to show how you can use
TinkerPlots to explore non-statistical concepts and
data. This activity in particular uses data about the
characteristics of numbers to develop number sense
and explore multiple representations.

Plot and Investigate

Q1 Answers will vary depending on grade level.

If students have left the icons colored by number,
they may notice only that the color gets darker
as the numbers increase.

Older students may notice patterns as they go
up the columns, such as “3 is added each time
I go up.” They may also notice that the third
column represents the multiples of 3.

Q2 Students should identify the third column
as “multiples of 3.” Some students may
appropriately use the terminology defined at
the beginning of the worksheet and say that
these are the numbers with “3 as a factor.”

Q3 Predictions will vary. An ideal answer is to
guess that a stack 5 wide and colored by factor5
will have all the multiples of 5, or the numbers
with 5 as a factor, in the last column.

Although this question may seem obvious to
you, and to many students, it is a necessary
building block for some students. The goal of
this question is to allow students who don’t see
the connection between factors and multiples an
opportunity to use inductive reasoning—to
recognize a pattern and make a generalization.
Allowing time to explore the pattern will
strengthen students’ reasoning skills and help
them make the connection between factors and
multiples. In fact, you may prefer to have

students repeat Q3 for a few other width-factor

combinations before moving on to Q4.

Q4 In general, a stack X wide and colored by factorX
will have all multiples of X, or all numbers with
X as a factor, in the last column.

Note: Obviously, many students will not be able
to state this in these general terms, but they may
be able to give several numeric examples.

After trying several width-factor combinations,
students should be able to explain why this
happens: “The numbers with 5 as a factor are all
multiples of 5. So, if the stack is 5 wide, all the
multiples of 5 will be on the end of the rows.”

Q5 The icon for 24 will be colored like all of the
numbers with 8 as a factor. This means that 8 is
a factor of 24, and 8 divides into 24 with no
remainder.

Q6 The icon for 24 is in the 3rd row of the stack. The
3rd row is related to the answer 3.

You may want to pause here and help students
see the connection to familiar rectangular
diagrams for multiplication. If you look at the
rectangle that is defined by 24, it is 8 wide and
3 high, or 8 × 3 = 24. It is because of the inverse
relationship between multiplication and
division that we are able to use this rectangular
model to solve 24 ÷ 8 = 3.

Q7 This plot shows that there are 3 complete groups
of 8 in 24 and this another way of explaining
why 24 ÷ 8 = 3.

This solution represents division by what may
be another familiar process—making equal
groups. However, because the row of icons is
continuous, some students may have trouble
recognizing it as groups.

If you like, you can point out one way to

translate between the representations in Q6 and

Q7: take the rectangle in Q6; imagine cutting the
rows into 3 separate rows; and then put the
rows end to end.

Q8 Students can use either method for these
division problems. The answers below show
alternating methods. The divisions with
remainders will be more challenging, although
not impossible. Whether students answer with
fractions or remainders will depend on grade
level and proficiency with division and
fractions.
a. 6; a stack 3 wide and colored by factor3

shows 18 is in the 6th row.
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b. 2; a stack 26 wide and colored by
factor13 shows 13 goes in 2 times.

c.

€

5 1
2 , or 5 remainder 1; a stack 2 wide and

colored by factor2 shows 11 is 1 more than

the 5th row, or

€

5 1
2 rows.

d.

€

2 2
3 , or 2 remainder 2; a stack 8 wide and

colored by factor3 shows that 3 goes in 2
whole times with 2 out of 3 left over.

Q9 Answers will vary.

Extensions

1. As written, this activity always uses a plot of
stacked, ordered, square icons. Challenge
students to experiment with other types of
plots that show interesting patterns. For
example, this ordered fused circle colored by
factor10 shows how multiples of 10 are evenly
spaced throughout the numbers from 1 to 100.

2. Have students create two plots stacked and
ordered by number and look for relationships
between them. They can try two stacks of
different widths colored by the same factor, or
two stacks of the same width colored by
different factors. Challenge students to explain
why the relationships exist. For example, these
two plots show that every multiple of 6 is also
a multiple of 3, but only half of the multiples of
3 are multiples of 6. This is easily explained
because 3 is itself a factor of 6. Students could
even compare a third plot—factor2—and see that
every multiple of 6 is also a multiple of 2, but
only a third of the multiples of 2 are multiples
of 6.

3. Students can begin to incorporate some of the
other attributes such as even, digit_sum, or
ones_digit. Exploring how these relate to the
factor attributes can introduce or reinforce
many division “rules,” such as “all even
numbers are divisible by 2” and “if a number
ends in 0 or 5, it is divisible by 5.” The plot
below illustrates the rule “if the sum of the
digits is a multiple of 9, then the number is
divisible by 9.”

4. Students in grades 6–8 who are beginning to
learn about prime numbers can use the stacks
and factor attributes to explore the concept of
prime. Because a prime number only has
factors of 1 and itself, the prime numbers will
never appear in the last column of a stack,
except for the first row. As an example,
consider 17. If you make stacks 2, 3, 4, . . . , 15,
16, and 17 wide, the only time 17 will be in the
last column is when the stack is 17 wide. So the
only factors of 17 are 1 and 17, and 17 is prime.
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5. Students in prealgebra or algebra could write
algebraic expressions for the patterns of
multiples in the stack. Consider this stack that is
4 wide and colored by factor17:

The first multiple of 17 is 1 more than the 4th
row of 4, the second multiple of 17 is 2 more
than the 8th row of 4, and so on. Students could
write the sequence of numbers as

4 × 4 + 1 = 17

4 × 8 + 2 = 34

4 × 12 + 3 = 51

4 × 16 + 4 = 68

Advanced students could even generalize the
sequence for the nth multiple of 17:

4 × 4n + n = 17n

Number Properties
(page 27)
Activity Time: 55+ minutes

Required Document: Number Properties.tp from
the folder Data and Demos | Exploring Data
Starters. This document uses the same data as
Factors.tp in this folder and Numbers.tp in the
folder Data and Demos | Science and Nature. In
each document the attributes are ordered by their
use in the activity.

Prerequisites: Students are familiar with square
numbers, prime numbers, and triangular numbers.
These types of numbers are described on the
worksheet, but having prior experience with these
classes of numbers will be extremely helpful.

It is best if students have first done Factors and
worked with the Numbers data. That activity will
give students experience with the type of data
contained in the TinkerPlots document and with
making stacks of rectangular icons.

Mathematics: Students will select, apply, and
translate among mathematical representations;
describe classes of counting numbers according to
characteristics (specifically, square numbers,
triangular numbers, and prime numbers); represent,
describe, extend, and generalize geometric and
numeric patterns.

Connections: This activity is primarily
mathematical. However, students will enjoy the
patterns that result from changing the width of the
plot and coloring by different factors. This can lead
them to general observations that they need not
formalize. For example, to get perfectly diagonal
patterns, you make the stack one wider or narrower
than the factor.

General Notes: The primary goal of this activity is
for students to recognize and generalize patterns in
types of counting numbers. Specifically, students
will create different arrangements of the numbers
from 1 to 100; color all of the square numbers,
triangular numbers, or prime numbers; and then
describe, explain, and extend the patterns they see.

A secondary goal is to show how you can use
TinkerPlots to explore non-statistical concepts and
data. This activity, in particular, uses data about
classes of numbers to develop number sense and
pattern recognition.

Because students will be doing open-ended
exploration of perfect squares and primes, it is best
that they are familiar with these classes of numbers.
Although the student worksheet begins with brief
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descriptions, this activity is not intended as a
comprehensive introduction of the concepts.
Therefore, the activity is best suited for students in
grades 6–8.

This activity is rather long and may take more than
one class period to complete. Because the activity is
divided into three explorations—squares, triangular
numbers, and primes—you could break it up over
three consecutive half-days. You could also divide
the activity into three completely separate activities
that you do independent of each other, or you could
pick and choose from among them.

A final note about vocabulary: The worksheet uses
square number and perfect square synonymously. This
could confuse some students. Also, the collection
includes attributes called square and perfect_square.
For this activity, students need to use perfect_square,
which tells whether the number is a perfect square;
square is a numeric attribute that gives the value
when you square the number.

Plot and Investigate

Q1 Answers will vary depending on grade level
and pattern-recognition skills.

In the simplest case, students should notice that
the perfect squares are always in the first or
fourth column. They might further notice that
the perfect squares in the first column are
always odd and that those in the fourth column
are always even.

Some students may notice patterns in the
number of cases between the perfect squares.
For example, in the first column the second
perfect square is 2 rows above the first, the third
perfect square is 4 rows above the second, the
fourth perfect square is 6 rows above the third,
and so on. Furthermore, in the fourth column
the second perfect square is 3 rows above the
first, the third perfect square is 5 rows above the
second, the fourth perfect square is 7 rows above
the third, and so on. (Note: Some students may
describe the separation by the number of rows
between, but not including, the perfect squares, in
which case they might describe the first
column’s pattern as “1 row between . . . , 3 rows
between . . . , etc.”)

Some students may notice that consecutive
perfect squares increase by odds: “4 is 3
more than 1, 9 is 5 more than 4, 16 is 7 more
than 9, . . .” However, because this insight
requires reading across the rows rather than
focusing on the columns of highlighted
numbers, it may be a rare response.

Note: Some students might prefer to swap the
axes in order to make the plot fit the window
better. This is okay, but then the patterns in the
numbers go from left to right.

Q2 The first perfect square after 100 will be in the
first column, 10 rows above 81. The second will
be in the fourth column, 11 rows above 100. The
next will be in the first column, 12 rows higher.
The next will be in the fourth column, 13 rows
higher. And the fifth will be in the first column,
14 rows higher. (Note: Accept any answer that
gets at this insight, including sketches that
attempt to extend the rectangular stack.)

Some students may recognize that the numbers
in each column increase by 4 as you go up, so
they might calculate the perfect squares as

81 + (4 × 10) = 121

100 + (4 × 11) = 144

121 + (4 × 12) = 169

144 + (4 × 13) = 196

169 + (4 × 14) = 225
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Other students might sketch an extension of the
diagram and fill in or count spaces to find the
numbers.

Be aware that some students may simply
calculate 11 × 11, 12 × 12, and so on. Although
this is an effective way to find consecutive
perfect squares, it does not use the pattern
illustrated by the plot.

Q3 Answers will vary, although there are two ideal
answers.

First, a stack that is 2 wide shows
a pattern of perfect squares
alternating from side to side. If
you look at the distance between
perfect squares in each column, the
pattern is similar to the stack that
was 4 wide, except the evens and
odds are not consecutive. For
example in the first column, you
go up 4 rows, then 8 rows, then
12 rows. Other students might
notice a pattern based on
alternating back and forth: “go up
1 row and right, go up 3 rows and
left, go up 3 rows and right, go up
5 rows and left, go up 5 rows and
right, . . .“

Second, a stack that is 1 wide (or a
continuous string) shows a pattern
of increasing by odds: “up 3, up 5,
up 7, up 9, . . .”

Some students might start experimenting with
types of plots other than stacks of rectangular
icons. For example, a fused circular graph shows
the increasing-by-odds pattern, too.

Q4 Plots and answers will vary. The next five
triangular numbers are 15, 21, 28, 36, and 45. A
good answer is that triangular numbers increase
by consecutive whole numbers: “go up 2, go up
3, go up 4, go up 5, . . .” Both the single stack
and fused circular graph below show this
pattern. (Note: If students count the case icons
between triangular numbers, the pattern starts at
1.) To help students see this pattern, you might
have them go back to the geometric pattern on
the worksheet and construct the next numbers
in the sequence. They should see that you
makethe next triangle by adding a bottom row
one unit longer than the previous bottom row.

Also, triangular numbers always come in pairs
of odds and evens: 1, 3 (two odds), 6, 10 (two
evens), 15, 21 (two odds), 28, 36 (two evens), and
so on. One way to highlight this pattern is to
separate the icons by triangular and then color
them by even. Again, you could ask students to
go back to the triangular diagrams and
challenge them to explain why this happens.

Q5 Plots and answers will vary. Unlike the perfect
squares and triangular numbers, the primes
have no consistent patterns. Some plots will
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appear to show patterns, but these patterns can’t
be extended for all primes. There are some
things students can say, however, about primes,
such as the fact that other than the number 2,
they are all odd numbers.

Two interesting stacks of square icons are 5
wide and 6 wide, as shown below. The 5-wide
stack shows that the primes tend to fall on
certain diagonals. The 6-wide stack shows that
the primes tend to be in the first and fifth rows.
(Students could investigate why this is.)

From having used fused circular plots for
triangular numbers, some students might do the
same for the primes. They might notice a slight
increase in the distance between primes as the
numbers get closer to 100.

Extensions

1. Students will likely notice that there is an
attribute called perfect_cube. You might define
cubic numbers and have them look for patterns
in the perfect cubes. Because there are only four
perfect cubes less than 100, students might
have a difficult time detecting any patterns.

You may want to have students add additional
cases, say for 101 to 250 (or higher), in order to
see more of a pattern. Note: Most of the
attributes in Number Properties.tp are
calculated with formulas, so it will be very easy
for students to add more cases. (Choose New
Cases from the Data menu and enter the
desired number of new cases. Values for all the
attributes except prime will be automatically
computed.)

2. Students will also likely notice that there are
attributes called square, square root, and cube.
These numeric attributes perform the indicated
function on number. For students in grades 6–8
who are beginning to learn about function
plots, you can create graphs of these attributes
by fully separating number on the horizontal
axis and fully separating square, for example,
on the vertical axis. Students can study the
general shape of these function curves and
describe similarities and differences.

3. You may be familiar with the Sieve of
Eratosthenes. Eratosthenes (276–194 B.C.) was a
Greek mathematician who devised a way to
“strain out” prime numbers from composites.
Essentially, because prime numbers cannot be a
multiple of another number, you cross out all
numbers that you know are multiples of 2, 3, 4,
5, and so on. You could do the Sieve with
TinkerPlots, but it is better to do it with an old-
fashioned number grid on a sheet of paper.
Draw a number grid, or print a stacked plot,
and cross off all the multiples of 2, then all the
multiples of 3, and so on, up through the
multiples of 17. Students will notice that for
several of the factors no additional numbers get
crossed out—their factors have already been
eliminated. For example, when you get to 10
you find that all its multiples have already been
eliminated by its factors 2 and 5.

Links

You and your students can find links to information
about square, triangular, and prime numbers at the
TinkerPlots Online Resource Center. Choose Online
Resource Center from the Help menu or go to
www.keypress.com/tinkerplots.
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Presenter	Notes	 changing means and medians

This activity is taken 
from Digging into  
Data with TinkerPlots, 
Key Curriculum Press, 
2008. 

 In this activity participants dynamically manipulate data to explore the effects of 

outliers on means and medians. This activity requires the document Scooters.tp, 
which you need to download from the TinkerPlots Online Resource Center and 

load onto participants’ computers. Although you can have participants complete  

the activity on their own, we suggest that you use this activity to model how they 

could use TinkerPlots in the classroom by treating it as a genuine lesson.

  1. Explain that in this activity you are going to model how you would use 

TinkerPlots in the classroom with your own students. Use the lesson notes  

on pages 41–46 to introduce the activity. Explain that this lesson follows  

one in which students looked at the ages of people who sustained scooter 

injuries. Make sure that all participants understand the definition of median.

  2. Participants probably will spend about 20 minutes on the worksheet. 

  3. Use the questions at the end of the lesson plan to summarize the activity. 

Point out the lesson notes to participants, and discuss the teaching techniques 

involved in the lesson.

• How did using the software make the concepts clearer (if it did)?

• Were there any ways using the software got in the way of the concepts?
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How Do Outliers Affect Means and Medians? 
Name:

Digging into Data with TinkerPlots Lesson 4.3 Changing Means and Medians 179
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When you look at the ages of the people who got scooter injuries, one 
person stands out from the rest: the 41-year-old woman. This case is called 
an outlier because its value for age is unusually high in comparison to the 
other age values in the data set. (A case with an unusually low age value 
would also be an outlier.) In this lesson you’ll explore how this outlier 
affects the mean and median ages for the data set.

 1. Open the TinkerPlots file Scooters.tp. Make a line plot of the ages. 
Lock the scale by double-clicking the gray box at the right end of the 
axis and clicking OK.

 2. Find the mean and median ages for people 
who got scooter injuries. Fill in the first row 
of the table below. (To find the values, click 
the arrow to the right of the mean button 
and choose Show Numeric Value(s).)

 3. What do you think will happen to the mean and median if you 
remove the data for the 41-year-old? Circle your choices.

The mean will: Stay the same Go up Go down

The median will: Stay the same Go up Go down

 4. Hide the data for the 41-year-old: Click on the dot for the 
41-year-old. Go to the Plot menu and choose Hide Selected 
Cases. Fill in the rest of the table. Round to the nearest hundredth.

Mean (yr) Median (yr)

Data set with all 28 cases

Data set without the 41-year-old

How much did the measure change? 

 5. Why did the mean change more than the median?
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How Do Outliers Affect Means and Medians?
continued
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 6. Put back the data for the 41-year-old: Go to the Plot menu and 
choose Show Hidden Cases. Then mix up the data and make a new 
line plot of Age.

 7. What is the youngest age you think someone would be riding a 
scooter?

What is the oldest age you think someone would be riding a scooter? 

 8. Change the scale to go from the youngest to the oldest ages you 
chose: Double-click the box at the left end of the scale. Enter the 
youngest age for Axis starts at and click OK. Repeat at the right end 
for the oldest age.

 9. Change the age of the 41-year-old case to see what happens to the 
mean and median. There are two ways to change the age.

• Click on the dot for the 41-year-old to show her data card. Click on 
the value 41 and type in a new age.

• Choose the Drag Value tool. Click on the dot for the 41-year-old. 
Move the dot along the scale to see how the values for mean and 
median change. The age will change on the data card.

  Keep your notes in the table (round to the nearest hundredth).

New ages I tried (yr) New mean (yr) New median (yr)

 10. What is the lowest mean and the lowest median you can get by 
changing this one age? (Do not use an age below the youngest age 
you chose in question 7.)

a. Lowest mean:   What age did you use? 

b. Lowest median:   What age did you use? 
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continued
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 11. What is the highest mean and the highest median you can get by 
changing this one age? (Do not use an age above the oldest age you 
chose in question 7.)

a. Highest mean:   What age did you use? 

b. Highest median:   What age did you use? 

 12. You can also change the mean or the median by adding a case to the 
data set. Pick an age that will raise the median. Add a case with that 
age: Choose the Add Case tool and click in the plot over the age that 
you want. A new case will be added.

What age did you add to raise the median? Why? How much did the 
median change?

 13. What did you learn about means and medians from this activity?

 14. Which measure—mean or median—do you think is more useful for 
summarizing the data about the ages of this group of people who got 
scooter injuries? Why?
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OVERVIEW

This exploration is designed to build students’ understanding of the 

differences between the mean and the median. Students learn that the 

median is less affected by extreme values than the mean. For this reason, the 

median is a good choice for describing what’s typical for data sets that have 

extreme values. The mean tends to be the first choice for students, perhaps 

because they are more familiar with it (through grades, sports, etc.). This 

lesson helps students to consider when the median might be a better choice.

Objectives

• Learn about the concept of an outlier in an informal way

• Explore the effects of an outlier on the mean and median

• Deepen understanding of differences between the mean and the median, 

particularly that the median is less affected by extreme values than the 

mean

Class Time: One class period

Materials

• How Do Outliers Affect Means and Medians? worksheet (one per 

student)

Data Set: Scooters.tp (data for 28 people with scooter injuries)

TinkerPlots Prerequisites: Students should be familiar with intermediate 

graphing.

TinkerPlots Skills: Hiding cases and changing case values are explained in 

this lesson.

LESSON PLAN

Introduction
 1. Introduce the task by connecting to the previous lessons. When your 

students looked at the ages of the people with scooter injuries, they 

probably made comments about the 41-year-old woman because she 

is so much older than the other people in the data set. Explain that this 

case is called an outlier because the value for age is unusually large in 

comparison to the other values.
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Note: At the middle-school level students work with an informal 

definition of outlier: a value that is unusually large or small in 

comparison to the other values in the data set. Statisticians use formal 

methods for determining outliers. Using one definition,  a value is 

considered an outlier if the distance from the value to the first quartile 

or third quartile (whichever is nearer) is more than 1.5 times the 

interquartile range.

 2. Introduce the question that students need to investigate: How does 

an outlier affect the mean and the median? Explain that students will 

have the opportunity to change the age of the 41-year-old to see what 

happens to these measures. Ask the class to come up with the lowest 

and highest reasonable ages for someone riding a scooter.

Exploration
 3. Have students work on the task independently or in pairs. They begin 

by finding the mean and median ages for the data set with all 28 values 

(question 2). Then, they see what happens to these measures when they 

remove the data for the 41-year-old (question 4).

Troubleshooting tips for hiding the case of the 41-year old:

• Note that you will hide the case only in the plot that is selected.

• When you hide a case, it is not included in the calculation of any 

measures in that plot.

• To hide multiple cases at once, draw a selection rectangle around 

them.

 4. Students tend to get very engaged with the task of changing the age to 

see the effect on the mean and the median. They can try two different 

methods to change the age of the 41-year-old: typing a new age on 

the data card and dragging the value in the plot. Directions for each 

method are provided on the worksheet. You may also want to do a 

whole-class demonstration.

Troubleshooting tips for dragging values:

• To get the effect of changing the mean and median as you drag 

values, it’s important that the scale of the plot be locked. Double-

click an endpoint and click OK to lock that endpoint. You can change 
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the endpoint value, but you don’t have to. You do have to lock each 

endpoint separately.

• Note that you have to choose the Drag Value tool again every time 

you let go of the mouse. If you don’t, dragging will rescale the plot as 

usual. To keep the Drag Value tool selected, hold down the Alt (Win) 

Option (Mac) key.

• If you drag a case off the axis, it will move into the stack of excluded 

cases and the axis will show that there’s more data off the end.

 5. As you circulate, ask students, “How can you get the median to change 

by changing the age of the 41-year-old?” [To change the median, you 

need to change the age to a value that is less than the original median 

of 10.5 years.] The lowest the median will go is 10 years old. Students 

tend to be surprised that the median doesn’t change when they increase 

the age.

  To explore this further, ask students to see if they can increase the 

median by adding a new case to the data (the data set will now have 

29 cases). By adding a new case that is higher than the original median 

of 10.5, the median will increase. Show students how to use the Add 
Case tool and ask them to investigate: What new age could you add to 

the data set to increase the median? (Choose the Add Case tool and 

click in the plot over the age that you want. A new case will be added 

with all the other values blank.) Another way to increase the median 

is to change one of the ages that is below the median to an age above 

the median. Ask students to explore the question: What happens to the 

median if you change the values of other cases besides the 41-year-old?

Wrap-Up
 6. Have a class discussion to help students clarify the differences between 

means and medians, particularly that medians are less affected by 

extreme values than means.

• Why did the mean change more than the median when you removed 

the 41-year-old from the data set?

• What was the highest mean you could get by changing this one value? 

The lowest?

• What was the lowest median you could get by changing this one 

value?
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• Why doesn’t the median change when you increase this one age?

What would you need to do to the data set to increase the median?

• What did you learn about means and medians from this activity?

• Which measure—mean or median—do you think is more

representative of the group of ages in this data set? Why?

ANswers

How Do Outliers Affect Means and Medians?
	2.–4.	 Answers for question 3 will vary.

Mean
(yr)

Median
(yr)

Data set with all 28 cases 11.75 	 10.5

Data set without the 41-year-old 10.67 	 10

How much did the measure change? 1.08 0.5

	 5.	 Sample student work:

	 7.	 Answers will vary.

	 9.	 Students should try ages in all parts of their chosen range (of youngest

and oldest ages for riding scooters), but not beyond it. For example,

changing the age to 30 yr gives a mean of 11.3 yr and a median of

10.5 yr. Changing the age to 5 yr gives a mean of 10.3 yr and a median

of 10 yr.

	 10.	 a.	 Answers will vary depending on the student’s choice for lowest age.

A lowest age of 3 yr gives a mean of 10.39 yr.

	 b.	 10 yr; any age below the original median of 10.5 yr will give this

value.
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 11. a.  Answers will vary depending on the student’s choice for highest age. 

A highest age of 60 yr gives a mean of 12.43 yr.

 b. 10.5 yr; any age above the original median of 10.5 yr will give this 

value.

 12. Any age above the original median of 10.5 yr will raise the median. If 

the age is between 10.5 and 11 yr, the new median age will be the same 

as the age added. If the age is above 11 yr, the new median age will be 

11 yr.

 13. Sample student work:

Jessica: I learned that means can be greatly altered by an outlier while 
medians are not.

Justin: Medians don’t change much, but means change drastically.

Eana: That each age changes the mean, the higher the age, the higher 
the mean, but for the median most of the time it stays the same.

Ian: The median depends on the # of #s in a data set while the mean 
depends on the size of the #s.

 14. Sample student work:

Jessica: Median: because even though the mean is the average, it can be 
thrown off by outliers, while the median (the middle number) is not.

Ian: Median because with the mean the data could be off because of a 
few odd balls.

  Comments: These students recognize that the median is a good choice 

for representing a data set that includes outliers.

Rand: Mean because it sums up all of the ages, not just the middle one.

  Comments: This student seems to have a misconception that the 

median is not representative of the group.

Nicole: Mean. I chose mean because it is more accurate. The median is 
just the middle number, and is usually the same as the mode.

  Comments: This student seems to share the misconception with the 

previous student that the median doesn’t represent the group. She has 

an additional misconception that the median is usually the same as the 

mode.
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Justin: Mean. Median doesn’t tell much. The median is judged by what’s 
above and below not that number.

  Comments: This student seems to have a similar misconception about 

the median.

Yom: Mean because mean changes if one number is change but median 
doesn’t. It is more specific than median.

  Comments: The student has chosen the mean because she thinks it is 

more “specific.” She is not focusing on how representative the mean is 

of the data set.
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This activity is taken 
from Digging into  
Data with TinkerPlots, 
Key Curriculum Press, 
2008. 

 In this activity participants look closely at two representations of the same ratio of 

two attributes: a scatter plot of the two attributes and a line plot (dot plot) of the 

ratios. How are the positions of points in these plots related? This activity requires 

the document Hall of Fame.tp from the TinkerPlots Online Resource Center.

  1. Introduce the activity by setting the context: Participants will look at data  

about players in the Basketball Hall of Fame. They will look at three different 

ratios: points per game, percentage of successful free throws, and percentage  

of successful field goals. Make sure participants understand the definitions of 

free throw and field goal.

  2. This lesson has two worksheets, Scoring Points and Free Throws and Field 

Goals, and will probably take participants about 30 minutes. If participants 

finish early, encourage them to postulate and explore other relationships in  

the Hall of Fame data set.

  3. Use these questions (which are from the lesson plan) to summarize the activity:

• How can you figure out a basketball player’s Points_per_Game ratio by using 

only the scatter plot?

• How does the information you get from the scatter plot of Free_Throw_

Attempts and Free_Throws_Made compare with the information in the  

line plot of Free_Throw_Percent?

• Are these players more successful at shooting free throws or field goals? How 

can you tell by comparing the scatter plots?

• In this lesson we saw a relationship between the positions of points on a line 

plot and their positions on a scatter plot. Would any line plot and any scatter 

plot have this relationship?

Presenter	Notes	 connecting line plots 
 and scatter plots
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Scoring Points 
Name:
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You will use two different plots to analyze the relationship between games 
played and points scored for basketball players in the Hall of Fame.

 1. Open the TinkerPlots file Hall of Fame.tp to see the data on 
75 players who are in the Basketball Hall of Fame.

 2. The attribute Points_per_Game is the average number of points the 
player scored per game. It is the ratio of Points_Total to Games_Total.

Points_per_Game = Points_Total___________
Games_Total

  For example, if you scored 200 total points and had played 10 games, 
you would have scored 20 points per game.

a. Make a line plot of Points_per_Game. Find the dot for 
W. Chamberlain, who has a Points_per_Game ratio of 30.1.

b. Find the dot for S. Martin. He played a total of 745 games and 
scored a total of 7337 points. What is his Points_per_Game ratio? 

 3. Use the dividers and percentages to find the middle 50% of the data. 
What are typical values for Points_per_Game for this group of players?

 4. On a new plot, make a scatter plot with Games_Total on the 
horizontal axis and Points_Total on the vertical axis.

 5. Use the Drawing tool to draw a line of fit on the scatter plot. Draw 
the line so that about half the points are above the line and about half 
are below it.

For the next two questions, you will select points in the line plot and see 
where they appear in the scatter plot. For example, if you select the four 
lowest dots on the line plot, TinkerPlots will automatically highlight those 
points on the scatter plot.
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 6. Where do you think the middle 50% of the Points_per_Game values 
will appear on the scatter plot?

a. Guess first. What is your guess? 

b. Select all the dots in the middle 50% on the line plot. Where are 
those points on the scatter plot? 

 7. Where do you think the top 25% of the Points_per_Game values will 
appear on the scatter plot?

a. What is your guess? 

b. Highlight the top 25% on the line plot. Where are the points on 
the scatter plot? 

 8. Add each new point to both plots above and label the points.

a. Player H has a higher Points_per_Game ratio than most players.

b. Player L has a lower Points_per_Game ratio than most players.

c. Player T has a typical Points_per_Game ratio.

 9. Which three basketball players are the best at scoring points? Where 
are these players on each plot?
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You will be investigating data on free throws and field goals in basketball. 
A free throw is a penalty shot.

• Free_Throw_Attempts is the number of free throws tried.

• Free_Throws_Made is the number of successful free throws.

• Free_Throw_Percent is the percentage of free throws that are 
successful.

A field goal is any successful shot, except a free throw, that is made during 
game play.

FREE THROWS

 1. Open the TinkerPlots file Hall of Fame.tp to see the data on players 
who are in the Basketball Hall of Fame.

 2. Make a line plot for the attribute Free_Throw_Percent.

a. If you made 30 free throws out of the 40 free throws you 
attempted, what is your free throw percent (Free_Throw_Percent)?

b. How many players have a Free_Throw_Percent that is less than 
65%?

c. What are typical free throw percentages for this group of players? 
Use evidence from the data.

 3. Make a scatter plot with the attribute Free_Throw_Attempts on the 
horizontal axis and Free_Throws_Made on the vertical axis.

 4. Draw a line of fit on the scatter plot.

Free Throws and Field Goals 
Name:
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 5. Experiment with highlighting points on the line plot to see where 
they appear on the scatter plot.

a. Where do the middle 50% of the Free_Throw_Percent values 
appear on the scatter plot ? 

b. Where do the bottom 25% of the Free_Throw_Percent values 
appear on the scatter plot? 

COMPARE FREE THROWS AND FIELD GOALS
Free throws Field goals

 6. Does this group of players tend to be more successful with free 
throws or field goals? How can you tell from the scatter plots?

 7. For this group of players, a typical Free_Throw_Percent value was 
between 75% and 81%. What are typical Field_Goal_Percent values for 
the group? Make a prediction and then use TinkerPlots to find out. 
Explain how you made your prediction.

Free Throws and Field Goals
continued
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Session 4 Bringing TinkerPlots into the Classroom

 Learning goaLs for this session

Consider how best to use TinkerPlots activities and demonstrations in support of 

the subjects you teach.

PedagogicaL refLection questions

The object of this discussion is to consider the specifics of how to make the most 

effective use of TinkerPlots in your own classroom. Discussing these questions with 

other participants will help you clarify your thinking and develop strategies for 

making TinkerPlots a valuable part of your teaching. The questions below may be 

useful. However, the discussion should be guided by the concerns of the group.

• How does using TinkerPlots activities or presentations complement other 

hands-on activities or other approaches to the content (if it does)?

• What benefits will TinkerPlots provide to my students?

• What challenges must I overcome to get the maximum benefit from TinkerPlots 

for my students? (Consider facilities and equipment, classroom management, 

students with special needs, your own knowledge and confidence, and so forth.)

• What are the advantages of doing activities as whole-class presentations?  

Of doing them with student pairs?

• How can I use TinkerPlots to make opportunities for students to do mathematics, 

science, or social studies? How does doing help students make sense of concepts?

• How can I collect and assess the work students do with TinkerPlots?

suPPorting MateriaLs

• Using TinkerPlots in Different Classroom Settings

• Methods of Collecting Student TinkerPlots Work

• TinkerPlots Reports and Presentations

resPonse to PedagogicaL refLection questions

to the Presenter

This discussion probably will take about 30 minutes. As the moderator of the 

discussion, make sure everyone’s concerns are addressed. As needed, point out the 

resources included in this guide.
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Using TinkerPlots in Different Classroom Settings

You can use TinkerPlots in a number of different ways with your students, ranging 

from having each student explore data individually to using one computer hooked 

to a projection device to analyze data as a whole class. However, whenever possible, 

encourage students to discuss among themselves the “story” of the data: what 

the data are, how they were collected, how particular attributes were probably 

measured, what questions they have about the data, and what they think they will 

find. After they’ve analyzed the data, allow time for students to share and discuss 

what they have found, encouraging them to use the graphs they’ve made to support 

their conclusions. Trying to convince each other, using the data, will help students 

develop critical thinking skills and show them the value of supporting claims with 

credible evidence. 

In a computer lab. Copy the activity you want students to complete and hand 

each student a copy to take to the school’s computer lab and complete there. 

Alternatively, students can work in pairs on an assignment together. We’ve found 

it beneficial to have each student at a computer even when they are working 

cooperatively, so that each of them can easily take control of the program. It  

can be difficult to follow what another person does to make a graph, because  

things can happen quickly in TinkerPlots.

As a class. Hand out the activity to students and have them complete the Think 

About It section at home the night before or as part of a discussion with a partner 

or small group. Then as a class discuss the various answers students came up with. 

Sharing their expectations about what they will see makes it clear to students 

that different people expect different things. This diversity makes them all the 

more eager to see what the data actually say. Then work as a class to make a graph 

(or several graphs) that answer the question on a single computer hooked to a 

projection device. Again have different students make suggestions about what  

to do, and what the graphs mean.

Part of the reason some students don’t need much instruction in using TinkerPlots 

is that they are quite familiar with technology. Some even have more experience, 

and much less fear, than their teachers. And if allowed to collaborate and share 

with one another what they have just learned about the software with one another, 

students are remarkable. In a large computer lab, you won’t need to tell students 

to collaborate. Often they will do it naturally. One student will figure out how to 

do something new, and very quickly, that know-how will spread around the room. 

Some students will quickly become the local source of TinkerPlots know-how, and 

we’ve observed that these are often the very students who otherwise seem lost or 

uninterested in class. If there is something you want to introduce into your students’ 

repertoire, find a suitable time to show one or two students. Again, the know-how 

will spread.



54	 Bringing	TinkerPlots	into	the	Classroom	 TinkerPlots	Workshop	Guide
	 ©	2007	Key	Curriculum	Press

Methods of Collecting Student TinkerPlots Work

Method Advantages Disadvantages

Viewing student work on 
their monitors, perhaps 
checking it off as you go 
around the room

• Very simple, and you’ll 
be doing it anyway

• Minimal written record

• Often you don’t get to 
every student during 
the class period

Collecting completed 
photocopies of activity 
worksheets

• Easy to collect and 
assess

• Worksheets are well-
structured to provide 
guidance to students

• No plots

• Worksheets can 
lack flexibility and 
don’t allow as much 
exploration

Collecting printouts of 
student files

• Easy to collect and 
assess

• Depends on your 
printer availability; 
having the whole class 
trying to print at the 
end of the period is  
not practical

Collecting work in student 
file folders on a network

• Easy to collect • Can be time-
consuming to assess 
multiple files

• Requires a network

Collecting student work 
on one or or more 
portable storage devices

• Doesn’t require access 
to a network

• Collection process can 
be complicated

• Can be time-
consuming to assess 
multiple files
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TinkerPlots Reports and Presentations

Sometimes you might want students to write a complete report of an investigation 

or another activity. The document Backpack Report.tp in the Data and Demos 
Demos folder is a sample student report for the first activity you did. Note that  

this document contains live graphs as well as static pictures and text boxes.

text boxes

  To create a text box, drag a Text icon from the toolbar into the document and start 

typing. You can format text using the Text menu.

Pictures 

You can copy TinkerPlots objects as pictures and paste them into both TinkerPlots 

documents and other applications such as Microsoft Word.

  1. Select the object and choose EditCopy As Picture.

  2. Click in a blank space in the document (in either application) and choose 

EditPaste.

To paste a picture from another application into a TinkerPlots document:

  1. Copy the picture to the clipboard.

  2. In TinkerPlots, click in a blank space in the document and choose EditPaste.
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Session 5 TinkerPlots Resources

 Learning goaLs for this session

Explore resources provided with TinkerPlots that you can use to help your students 

achieve your learning goals.

tinkerPLots Movies

TinkerPlots comes with five movies. To watch one, choose TinkerPlots Movies 

from the Help menu. Each movie is about 5 minutes long. TinkerPlots Basics is  

a good introduction for both teachers and students. After watching this movie,  

most students can go right into working with data. Adding Data shows three 

different methods to get your own data into TinkerPlots. Making Common  

Graphs, Comparing Groups, and Exploring Relationships all show different  

ways you can use TinkerPlots to help students understand data. 

Data anD DeMos

TinkerPlots comes with about 40 data sets ready for you and your students to use. 

Go to the Data and Demos folder (in the TinkerPlots application or program 

folder) and open a subfolder (Health, Science and Nature, Social Studies, or 

Sports and Entertainment). Each data set contains one or more questions for 

students to explore. We suggest you have students treat these like any investigation: 

Make a hypothesis, analyze the data, and then communicate their conclusions. 

The Demos folder contains nine demonstrations showing more advanced 

capabilities of TinkerPlots. These are for teacher use, although some are  

meant to be modified and presented to students.

tinkerPLots heLP

Find out how to do all sorts of things with TinkerPlots by choosing TinkerPlots 
Help from the Help menu. This workshop session includes a TinkerPlots Help 

Scavenger Hunt that you can use to familiarize yourself with Help and to learn 

about some things you might not have known you could do. You can also use  

the TinkerPlots Checklist at the end of this guide as a quick reference for what  

you can do.

research on stuDent thinking about Data

This article, from the book Exploring Data with TinkerPlots, describes recent 

research that influenced both the design of TinkerPlots and the types of data  

and activities included with it. The article appears on page 60 of this guide.



exPLoring Data with tinkerPLots

This book comes with all full editions of TinkerPlots and contains seven activities 

for use in grades 4–8 as well as notes on getting started, learning TinkerPlots, and 

teaching with TinkerPlots. See the activity notes for the backpacks activities in this 

book for some discussion of what to expect from younger and older students. A 

PDF file of this book is available in the TinkerPlots Help folder (in the TinkerPlots 

application or program folder).

tinkerPLots onLine resource center

At www.keypress.com/tinkerplots/resources, you can find links to websites with 

data as well as share activities and data sets with other teachers.

to the Presenter

This final session is designed to allow you and workshop participants some 

flexibility in what to focus on. You can have participants explore these options 

independently, or you can have the whole group complete one or more of the 

activities. For example, you might watch one or more of the movies as a group, or 

have participants work with a particular data set in the Data and Demos folder.
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TinkerPlots Help Scavenger Hunt

Several advanced capabilities of TinkerPlots are listed on these pages. Your task is to 

learn how to do as many of them as you can using TinkerPlots’s online Help system. 

(If you already know how to do one of these, don’t bother looking it up in Help.)

To open Help, choose TinkerPlots Help from the Help menu. You can search for 

items using the Contents, Index, or Search functions at the left of the Help window. 

The Help system sometimes refers to the upper toolbar and the lower toolbar. The 

lower toolbar is located at the bottom of the plot window and includes the Mix-up 

button and icon types. The upper toolbar is the collection of buttons at the top of 

the document window and includes the Separate, Order, and Stack buttons.

  1. Change the color of values of a category attribute. Here the color for males was 

changed from yellow (left) to the stereotypical blue (right).

                

  2. Remove an attribute from an axis without using the Mix-up button or undoing. 

In this example, the attribute Grade was removed from the vertical axis (left) to 

graph PackWeight all by itself on the horizontal axis (right).

               



  3. Make a pie graph. This pie graph   

shows there are about equal numbers  

of that males and females in the  

backpack data set.

  4. Set the axis endpoints and interval widths to specific values. In this example, the 

axis showing BodyWeight that TinkerPlots automatically gave (left) was changed 

to start at 0 and have a bin width of 10 (right).

               

  5. Make a filter to hide some cases in a plot. This plot was filtered to show the data 

for only the third graders.
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During the last ten years, statistics educators have learned quite a bit about how 

younger students learn to reason about data and how experts approach data 

differently from ordinary people or novices. This research influenced both the 

design of TinkerPlots and the type of data and activities included with it. Here we 

briefly describe some of what we have learned from research and how we’ve applied 

it to TinkerPlots. For a more detailed description of this research, see Chapter 13 of 

A Research Companion to Principles and Standards for School Mathematics (2003) 

published by the National Council of Teachers of Mathematics (NCTM). Other 

research articles are listed in the TinkerPlots Online Resource Center at www.

keypress.com/tinkerplots.

DeveLoPing an aggregate view of Data

Experts look at a group of data as a collection, or aggregate. When they look at a 

histogram or stacked dot plot, for example, they tend to see its general shape, how 

spread out it is, and where the data are centered. When experts compare two groups 

(say two different stacked dot plots showing people’s heights) they generally base 

those comparisons on these aggregate features. For example, an expert looking at 

two distributions of height for men and women might conclude that men tend to 

be taller than women by comparing the locations of the centers (for example, the 

means) of each distribution.

Students new to the study of data tend not to see these aggregate features. Rather 

they see individual cases or subgroups of individuals with the same, or nearly 

the same, value. Looking at the same distribution of height, students might focus 

mostly on individuals on the extreme ends of the distribution. Alternatively, they 

might tend to see short people, average people, and tall people, and reason about 

these as three different groupings. When students compare two groups, they often 

compare the number of cases at one of the extreme ends of the distributions. For 

example, a student looking at a graph showing men’s and women’s heights might 

argue that the men are taller because there are more of them above 6 feet. One 

problem with this comparison is that it doesn’t take into account the number of 

cases in each group. If we had a group of 1000 women and 10 men, we would 

probably have more women than men above 6 feet. This method of comparing 

numbers in common slices of the distributions often leads to faulty conclusions.

Researchers have also found that it usually isn’t fruitful to simply tell students that 

what they are doing is wrong and to recommend an alternative. If students don’t 

understand why their methods are flawed and why the alternative is better, they 

will do what you ask now, but later revert to what makes more sense to them. This 

research led us to take a different approach in TinkerPlots. We have included tools 
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students can use to look at and compare graphs using their intuitive methods. For 

example, students can use dividers and reference lines to break up distributions into 

parts and click a button to quickly get counts of cases in different parts. We believe 

that by allowing students to use methods that make sense to them, and having them 

discuss what they do with other students and with teachers, they will come to see 

the limitations in their approaches and develop more powerful methods.

Describing centers of Distributions

Rather than using means and medians to summarize numeric data, researchers 

have reported that most people, including young students, prefer to describe a 

distribution using a “center clump”: for example, “Most of the data are between  

15 and 25.” Dividers and hat plots are TinkerPlots tools designed specifically to  

help students describe data in terms of these informal averages. Students can also 

use the Drawing tool to show where they think the bulk of the data are. It is fine  

for students to summarize groups and to describe differences by saying that one 

group’s center clump is higher up than another group’s. We expect that formal 

averages, like means and medians, will then eventually make more sense when 

students see that these are almost always located within what they see as the  

center clump.

staying grounDeD in the Data

Many researchers have reported the importance of students keeping in mind what 

a case is—that a data point on a graph is not simply a number or dot, but that it 

is a measurement for a case (for example, a person’s height). Often when students 

(or experts) get confused looking at a graph, it is because they lose this connection 

between a case and a point on the graph. In TinkerPlots, students can, at any 

time, click a point on a plot to see the data card for that individual case and to 

automatically highlight that case in any other plots that may be open. Again, this 

helps students keep in mind what a case is. It also helps them analyze their data, 

because when students highlight a case that has a high value for one attribute, they 

can see where that case is located in another graph of a different attribute. For these 

reasons, in all TinkerPlots graphs—even histograms, box plots, and pie graphs— 

it is easy for students to see cases and how those individual cases work together to 

form a particular graph. When one plot changes to another, TinkerPlots animates 

the transformation to help preserve the integrity of the case.

TinkerPlots	Workshop	Guide	 TinkerPlots	Resources	 61
©	2007	Key	Curriculum	Press

Research on Student Thinking About Data
continued



TinkerPlots Checklist

This list describes some of the many things you can do with TinkerPlots. Some  

you already know how to do, and some you may never need to do at all. If you  

like, use this list to keep track of your expertise with TinkerPlots. You can also  

scan this list to find out about some of the things you didn’t know TinkerPlots 

could do and pick interesting ones to explore either through experimentation  

or through TinkerPlots Help.

getting Data into tinkerPLots anD reaDy for stuDents

• Enter data directly into a data card, a case table, and a graph.

• Rename a data set.

• Import data from the web, from Excel, and from Word.

• Add an attribute defined by a formula.

• Cut, copy, and paste attributes and cases.

• Duplicate an object.

• Delete an object.

• Show values in scientific notation.

• Round values using a formula.

• Sort cases in a table.

• Create realistic data using a random number generator.

• Combine data sets.

• Add multiple new cases at once.

• Lock a data set so that students can’t change it.

working with PLots

• Add a drawing to your plot and remove it.

• Remove an attribute from an axis without using the Mix-up button.

• Make a pie graph, a value bar graph, and a rectangle graph.

• Set axis endpoints and interval widths to specific values.

• Lock the color in a plot.

• Turn off plot color and highlight cases in two or more plots.

• Drag values while keeping the axes stationary.
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• Make a box plot.

• Divide a plot so that each part has the same number of cases.

• Remove some cases from a plot by filtering.

• Hide some cases in a plot.

• Change bin widths in a histogram by dragging lines.

• Reorder category bins.

• Label icons by your attribute of choice.

• Change the colors of categories and of a color gradient.

• Use a filter with a slider to animate a time series graph or to grow a sample.

• Make a value table by hiding icons in the plot.

• Connect the dots in a plot.

• Reverse axis endpoints.

• Use continuous-style bins.

Making rePorts or Presentations

• Make a picture of a graph.

• Import a picture from another application.

• Make a text box and format text.

• Make text in graphs larger.

• Show page breaks and print a document.

• Export data to another application.

• Iconify an object to save space.

• View an object in its own window.

custoMizing DocuMents

• Remove some plot features from the toolbars.

• Hide attributes in the data cards.

• Change image icons.

• Hide objects in the document.
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continued
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